Set 1

1. Which view would you use for comparing your project schedule to the baseline?
   A) Gantt Chart
   B) Levelling Gantt
   C) Network Diagram
   D) Tracking Gantt

2. Which of the following is **NOT** a Resource Type in Microsoft Project 2013?
   A) Labor
   B) Material
   C) Cost
   D) Work

3. How would you configure Microsoft Project to display the Project Summary for all new projects?
   A) The Show Project Summary Task checkbox via the Schedule Project Options
   B) The Show Project Summary Task checkbox via the Advanced Project Options
   C) Project Summary Task checkbox via the FORMAT tab
   D) Project Summary Task checkbox via the VIEW tab

4. In order to accommodate an executive who is using Microsoft Office 2007, you have to Save your Microsoft Project 2013 file as an older version. You want to make sure that the new file contains no added constraints. What should you do before saving the file?
   A) Make sure all tasks are Active
   B) Make sure all of the tasks are automatically scheduled
   C) Make sure all of the tasks are manually scheduled
   D) Make sure all of the summary tasks are automatically scheduled

5. Your project milestones are slipping past the original delivery dates, and you need to display the slippage visually. What should you do to the milestones?
   A) Add a “Finish No Later Than” constraint
   B) Add a “Finish On” constraint
   C) Add a Finish Date
   D) Add a Deadline

6. Task A and Task B are in a Finish to Start relationship that was manually scheduled. Task A has a duration of 4 days and Task B has a duration of 8 days. After talking with the developer, you find out that Task A will actually take 6 days. You update the durations for Task A to 6 days, but you notice that Task B now starts 2 days before Task A ends. What should you do to maintain the original task relationship?
   A) Update the the Task relationship to a Finish to Finish relationship
   B) Add a “Start No Earlier Than” constraint
   C) Click the “Respect the Links” button on the Task menu
   D) In the Team Planner view move Task B to the right 2 days
7. Task A has a task type of Fixed Work with a duration of 6 days, work of 48 hours, and units of 100%. You decide to decrease the work to only 24 hours. How will this affect the other two variables.
   A) The Duration will decrease by 3 days.
   B) The Units will decrease by 50%
   C) the Duration will increase by 3 days.
   D) The Units will increase by 50%.

8. Which view allows you to see all tasks assigned to a single Resource?
   A) The Task Form
   B) The Task Sheet
   C) The Resource Form
   D) The Resource Sheet

9. Which view helps visually display resources that are over-allocated via vertical bar graph?
   A) The Resource Sheet
   B) The Resource Graph
   C) The Team Planner
   D) The Resource Usage

10. Your resource, Kelly, originally scheduled time off the Friday after Thanksgiving, and the project was schedule knowing she was out. Due to a strict deadline, your resource is now working the Friday after Thanksgiving. How would you update the project to reflect this change?
    A) Update the Working Time via the Task calendar
    B) Update the Working Time via the Resource calendar
    C) Remove the Exception from the Resource calendar
    D) Remove the Exception from the Project calendar

11. What is the easiest way to view the legend for the Gantt chart?
    A) Double click an empty area on the Gantt Chart
    B) Right click the Gantt Chart and click View Legend
    C) On the View tab, click the Legend checkbox
    D) On the Format tab, click the Legend checkbox

12. In order to accommodate an Executive who is used to analyzing project data via an Excel Pivot table, what should you do?
    A) Export the project data into Excel and use Excel to create the Pivot tables
    B) Use the default Dashboard Reports feature
    C) Copy and paste the data from Microsoft Project to Excel
    D) Use the default Visual Reports feature

13. Which of the following is NOT a Report category?
    A) Dashboards
    B) Resources
    C) In Progress
    D) Schedule
    E) Costs

14. You need to find all of the Milestones on the project, without hiding other tasks or changing the order of the tasks. What should you do?
    A) Use the Filter on Milestones
B) Use the Group by on Milestones  
C) Use the Highlight on Milestones  
D) Use the Duration column to filter on 0d tasks  

15. You are using the Resource Sheet to list all of your resources for the project. There is a piece of equipment that costs $15/hour and each time it is used there is a $20 fee. What resource type should you pick?  
A) Labor  
B) Material  
C) Cost  
D) Work
Set 1 Answers:
1) D
2) A
3) B
4) B
5) D
6) C
7) A
8) D
9) B
10) C
11) A
12) D
13) D
14) C
15) B
Set 2

1. You would like to add a row at the top of your project schedule that rolls up or sums all the information below. What is the easiest way to do that?
   a. Insert a Summary Task at the top of your schedule and indent all tasks below it.
   b. Enable the Project Summary Task through the Format tab on the Ribbon.
   c. Insert a task at the top of your schedule and establish the predecessors appropriately.
   d. Enable the Project Summary Task through Project tab and Project Information.

2. You would like to see graphically that your milestones have slipped passed the agreed upon Finish dates. What should you add to the milestones?
   a. A Finish date
   b. A “Must Finish On” constraint
   c. A Deadline
   d. A “Finish No Later Than” constraint

3. You have a task that spans 5 days in Duration, has only one Resource assigned, and consists of 40 hours of planned Work. Due to a change in a delivery date, you discover that you now need to complete this task in 3 days or less. You have an additional resource on the team who could help with this task. How should you configure this task before adding the second resource?
   a. Set Type to Fixed Duration, and Effort Driven to Yes
   b. Set Type to Fixed Units, and Effort Driven to Yes
   c. Set Type to Fixed Work, and Effort Driven to No
   d. Set Type to Fixed Work, and Effort Driven to Yes

4. You have a resource on your team who is only available 50% of the time. She is responsible for working on only one task next week. The original estimate of Work for this task was 20 hours. She just informed you that based upon some new found information, the task is really going to take 30 hours worth of Work to complete. There is no one else that can assist with this task. How should you configure this task before updating the Work?
   a. Set Effort Driven to Yes, then input 30 hours Work
   b. Set Type to Fixed Duration, then input 30 hours Work
   c. Set Type to Fixed Units, then input 30 hours Work
   d. Set Effort Driven to No, then input 30 hours Work

5. You were just asked to take over a project. The previous project manager had developed a schedule in Microsoft Excel. It has 262 tasks, each with Duration in days and Resource Names assigned. You prefer to manage your projects using Microsoft Project. What’s the best way to get the information out of Excel and into Microsoft Project?
a. Use the Gantt Chart Wizard
b. Select all the information in Excel, Copy and Paste directly into Microsoft Project
c. Open the Excel file directly from within Microsoft Project, which will convert and map Tasks, Durations, and Resources assigned into Project fields
d. Create a VBA macro

6. You are in the process of creating a new schedule in Microsoft Project. You want to ensure that all tasks added to the schedule will be “Auto Scheduled”. What should you do?
   a. Under Schedule Options, set New tasks created to “Auto Scheduled”
   b. Under Advanced Options, set New tasks created to “Auto Scheduled”
   c. Use the Task Mode field within the Gantt Chart view to change the value to “Auto Scheduled”
   d. Highlight all tasks and use the “Auto Schedule” button

7. You just updated the Duration of a task. You notice that the Finish Variance at the “Level 0” or “Project Summary” row is now showing 5 days. What does this mean?
   a. The project is on schedule
   b. The project is 5 days behind schedule
   c. The project is 5 days ahead of schedule
   d. The project needs rebaselined

8. Working with your project sponsor, you determine that a few tasks are out of scope for your project. You would like to somehow adjust your schedule to eliminate those tasks, but you don’t want to simply delete them just in case they may be needed in the future. What should you do?
   a. Move the task to after the end date of the project
   b. There is nothing else you can do but delete the task
   c. Remove the Predecessor and Successor from the tasks
   d. Inactivate the tasks

9. You click on the Resource Sheet view and notice that one of the resource names appears in Red. What does this mean?
   a. The name is misspelled
   b. The resource is not assigned to any tasks
   c. The resource is over-allocated
   d. The resource has not been properly added to the Resource Sheet

10. You just updated your schedule. You need a graphical view that shows how your current schedule compares to the Baseline. Which view should you use?
    a. Detail Gantt view
    b. Tracking Gantt view
    c. Levelling Gantt view
11. You are managing a project to add a new kitchen onto an older home. The Plumber owns the task of Install Plumbing. The Electrician owns the task of Install Electric. Both tasks span a duration of 5 days each. The initial plan was to have all the plumbing complete before installing the electric. However, you would like to compress the overall duration of these two tasks, so you talk to both the Electrician and the Plumber. It is decided that the Electrician could begin his work 2 days before the Plumber is complete. How would you alter your schedule?
   a. Figure out which day the plumber will be complete, subtract two days, then input that as the Start date for Install Electricity
   b. Establish a Finish-to-Start relationship between Install Plumbing and Install Electricity, and include a 2 day Lag
   c. Establish a Finish-to-Start relationship between Install Plumbing and Install Electricity, and include a -2 day Lag
   d. Establish a Start-to-Finish relationship between Install Plumbing and Install Electricity, and include a 2 day Lag

12. What is the easiest way to show only the Milestones and Summary Tasks within your project schedule?
   a. Click on >View, >Filter, >Milestones
   b. Click on >View, >Group by, >Milestones
   c. Insert the column Milestone, click on the dropdown filter on the column, then choose “Yes”
   d. Using the AutoFilter, filter for “Duration = 0”

13. The PMO manager comes to you because she realizes you have good experience with Microsoft Project 2013. She is wondering if there is an out of the box view or report that shows Actual Work, Remaining Work and Baseline Work. Which do you recommend?
   a. Project Overview dashboard
   b. Resource Allocation view
   c. Task Usage view
   d. Work Overview dashboard

14. You are about to begin a new project. Which of the following Resource Types is NOT available in Microsoft Project 2013?
   a. Labor
   b. Material
   c. Work
   d. Cost

15. You are in the process of updating your schedule. You notice that one task has 3 days of Remaining Duration. You speak with the person assigned to this task and they state that the work is complete. What should you do?
   a. Mark the task 100% Complete
b. Enter 0 in Remaining Duration
c. Enter a status date for the task
d. Reschedule uncompleted work
Set 2 Answers:

1. b
2. c
3. d
4. c
5. c
6. a
7. b
8. d
9. c
10. b
11. c
12. a
13. d
14. a
15. b
Potential MS Project 74 -343 Questions

Set 3

1. You use Project Professional 2013 to manage a project that has customer-required milestone completion dates. You need to see graphically that your milestones have slipped beyond your customer-required dates. What should you add to the project milestones?
   A. a Must finish on constraint
   B. a finish date
   C. a deadline
   D. a Finish no later than constraint

2. You manage a project by using Project Professional 2013. Your project is updated with changes to the baseline for selected tasks. You back up your project file before you start your next tracking cycle. After completing the tracking cycle, you notice that the baseline duration values on some of the summary tasks are not correct. You need to correct these values before re-entering the tracking data. You open the backed up version of the project schedule. What should you do next?
   A. Manually update the summary tasks with the new duration values.
   B. Reset the summary tasks to manual scheduling.
   C. Ensure the tasks durations are of the same denomination values. Then reenter the tracking data.
   D. Reset the baseline checking the Roll up baselines to all summary tasks option. Then reenter the tracking data.
Potential MS Project 74 - 343 Questions

Image 3 of 5

You are a program manager. Your project managers use Project Professional 2013 to manage projects. The project managers want to utilise the same resources across their projects. You need to combine the projects, as well as the project resources, to save allocations across the projects. What should you do?

A. Copy and paste all resource assignments into a Master file.
B. Share resources from an external resource pool.
C. Create a Master project and insert subprojects by using Link to project.
D. Open all projects in a new window.

Select the best choice.

Image 4 of 5

Your company uses Project Standard 2013 to track project progress. You need to accurately calculate cost performance index (CPI) as a health indicator. Which three actions should you perform? (Each correct answer presents part of the solution. Choose three.)

A. Ensure there is a value in the Status Date field.
B. Ensure there is a value in the Standard Rate field.
C. Ensure Task Dependencies exist in the schedule.
D. Enter actual progress information.
E. Level resources within available slack.

Select all that apply.
You are a project manager who uses Microsoft Excel 2013. Your company decides to migrate all of the current projects in Microsoft Excel 2013 to Project Professional 2013. They allow all employees to spend 5 hours migrating each project plan. Your current and unique project plan has 462 tasks with duration in days, and resources have been assigned and named. You have a status meeting in two days. You need to provide your project’s information by using Project Professional 2013. What should you do?

A. Create a new project plan in Project Professional 2013 and use the Gantt Chart Wizard to import from an Excel Workbook.
B. Rename the Excel file from .xlsx to .mmp, and open it by using Project Professional 2013, activating the Mapping Excel Workbook feature. Map tasks, durations, and resources assigned into Microsoft Project fields.
C. Open the Excel File .xlsx directly from Project Professional 2013, which will convert and map tasks, durations, and resources assigned into Project fields.
D. Create a VBA macro by using the Excel Record Macro feature to import all tasks, durations, and resources assigned from Excel into your new Project Professional 2013 project plan.

Select the best choice.
Set 4

You are a project manager, and you use Project 2013 for a large construction project. You create the work breakdown structure (WBS) and plan to add the following resources for your project: concrete, construction supplies, and airline tickets. You need to add these resources to your schedule. Which two resource types should be created for these resource examples? (Each correct answer presents part of the solution. Choose two.)

- A. Add Generic Resources.
- B. Add Cost Resources.
- C. Add Work Resources.
- D. Add Material Resources.

Answer: B, D
You are managing a project by using Project Professional 2013. Your project schedule contains 1,000 tasks which are in outline format. You discover that the Design summary task is located below the Build summary group of tasks.

You need to move the Design summary task and its detail tasks to the proper location.

What should you do?

- **A** Click on the Design summary task name and drag it above the Build group of tasks.
- **B** Make the Design summary task grouping a manual task, and drag the Design task name above the Build group of tasks.
- **C** Cut all of the tasks below the Design summary task and paste them above the Build group of tasks.
- **D** Click on the ID number for the Design summary task grouping and drag the group above the Build group of tasks.

**Answer:** D

You are a project manager and have built a project plan by using Project Professional 2013. Your project plan has both fixed duration and fixed work tasks.

You have been asked to denote key existing tasks as milestones in the Gantt view.

What should you do?

- **A** Format the bar styles in the Gantt view to denote the tasks as milestones.
- **B** Enter the word Milestone in the Task Duration column to set the task as a milestone.
- **C** Set the Duration column to 0 to set the task as a milestone.
- **D** Navigate to View, Task Styles, select Milestones, and then select the black diamond.

**Answer:** C
You are a manager for an organization that uses Project Professional 2013.

A critical project shows average finish variance values between 5-10 days for the tasks.

You need to interpret these variance values to determine the next course of action to take.

What do these variance values mean?

- The project is on schedule.
- The project is running between 5-10 days ahead of schedule.
- The project is running between 5-10 days behind schedule.
- The project is averaging a normal performance timeline.

Answer: C

---

You use Project Professional 2013 to manage a project for your organization.

You are tracking work in a project which contains a baseline and resource assignments. You want to view the work variance for a specific resource for a specific task.

You need to choose a view that will show this information.

What should you do?

- View the Resource Sheet that shows the Work table.
- View the Gantt chart in split view with Task form formatted to show Work Details.
- View the Resource Sheet view and insert the Work Variance field.
- View the Task Usage view and insert the Work Variance column on the left side of the view.

Answer: D
You are a project manager, and your organization uses Project Standard 2013.

You have created a non-working day in a resource’s calendar; however, the HR department notifies you that the resource will work that day after all.

You need to reflect this change in the project in the most efficient manner.

What should you do?

- A. Open the Project calendar and mark the work day as working.
- B. Open the resource’s working calendar and edit the Work Week details to set the day as working.
- C. Open the resource’s working calendar and delete the exception.
- D. Open the resource’s working calendar and mark the day as working.

**Answer:** C

You are a Project Manager who uses Project Professional 2013.

You manage a critical project, which is synchronized with a Microsoft SharePoint Task List.

One of your team members has changed a task priority to High in SharePoint, and you do not see the changed data in Project Professional 2013.

What should you do?

- A. Use the Organizer to copy the Priority field from the SharePoint Task List.
- B. Map the Priority field from SharePoint to Project by using File, Info.
- C. Map the Priority field from SharePoint to Project by using Project, Custom Fields, Import Field.
- D. Use the Task Information box to copy the Priority field from the SharePoint Task List.

**Answer:** B
Potential MS Project 74 - 343 Questions

You manage a project for an organization that uses Project Professional 2013. You reset the baseline for some selected tasks. After the baseline has been updated with the new values, you realize that some of the summary baseline duration values are not correct. You need to resolve this problem. What should you do?

- A. Update the summary tasks manually with the new duration values.
- B. Change all task durations to the same denomination values, such as days, weeks, or months.
- C. Reset the baselines for the selected tasks and select the Roll up baselines to all summary tasks option.
- D. Reset the summary tasks to manual scheduling.

Answer: C

You are a program manager. Your project managers use Project Professional 2013 to manage projects. The project managers want to utilize the same resources across their projects. You need to combine the projects, as well as the project resources, to see allocations across the projects. What should you do?

- A. Copy and paste all resource assignments into a Master file.
- B. Share resources from an external resource pool.
- C. Create a Master project and insert subprojects by using Link to project.
- D. Open all projects in a new window.

Answer: B
You are an independent project manager who uses Project Professional 2013.

You work on multiple projects for different customers and use one project to manage all their tasks. You create a custom field called Customer Name to identify the customer, and you use the Cost field to monitor the amount of money for each task.

You need to view the most expensive detail tasks in the top of your table without subtotals and summaries.

You turned off summary tasks. What should you do next?

- A Set the Sort by option to Cost Descending.
- B Create a custom group based on Cost and Customer Name fields. Define a group by Cost with order as ascending.
- C Set the Sort by option to Cost Ascending.
- D Create a custom view based on Cost and Customer Name fields. Define a group by Cost with order as descending.

Answer: A